Sage 100 Contractor 2014
(formerly Sage Master Builder)
Release Notes
Canadian and United States Editions
Version 19.7

This version of the software has been retired.
This is a publication of Sage Software, Inc.

© 2014 The Sage Group plc or its licensors. All rights reserved. Sage, Sage logos, and Sage product and service names mentioned herein are trademarks of Sage Software, Inc. or its licensors. All other trademarks are the property of their respective owners.

Microsoft® SQL Server® and the Windows logo are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or in other countries.

Your use of this document and the Sage product(s) described herein is governed by the terms and conditions of the Sage End User License Agreement (“EULA”) or other agreement that is provided with or included in the Sage product. Nothing in this document supplements, modifies or amends those terms and conditions. Except as expressly stated in those terms and conditions, the information in this document is provided by Sage “AS IS” and Sage disclaims all express, implied or statutory warranties of any kind, including but not limited to the warranties of merchantability, fitness for a particular purpose or of non-infringement. No implied license is granted to you under any Sage intellectual property or trade secret right. Sage reserves the right to revise, supplement or remove information in this document at any time without notice to you or others.

Sage End User License:  www.sage.com/us/legal/eula

Date: 7/8/2016
Contents

July 2016 Update (Build 19.7.58) ................................................................. 1
  U.S. Payroll Tax Tables—July 2016 ......................................................... 1

July 2016 Update (Build 19.7.57) ................................................................. 2
  Canadian Payroll Tax Tables—July 2016 .................................................. 2
  Enhancements for the Canadian Edition .................................................. 2

February 2016 Update (Build 19.7.52) ......................................................... 4
  Fixes for U.S. and Canadian Editions ...................................................... 4
  Fixes for the Canadian Edition ............................................................... 4
  Fixes for the U.S. Edition ........................................................................ 4

January 2016 Update (Build 19.7.43) .......................................................... 5
  U.S. Payroll Tax Tables ......................................................................... 5
  Enhancements for the U.S. Edition ........................................................ 5
  Fixes for U.S. and Canadian Editions ..................................................... 6

U.S. Payroll Tax Tables—December 2015 .................................................. 8
  Federal Payroll Tax Changes ............................................................... 8
  Other Government-Mandated Payroll Tax Changes .............................. 8

Canadian Payroll Tax Tables—December 2015 ....................................... 9
  Federal Payroll Tax Changes ............................................................... 9
  Quebec Payroll Tax Changes .............................................................. 9
  Other Provincial and Territorial Payroll Tax Changes ............................ 9

Enhancements in Version 19.7 ................................................................. 10
  General Improvements .................................................................. 10
  Enhancements for the U.S. Edition ...................................................... 10

Fixes in Version 19.7 .............................................................................. 13
  Fixes for the U.S. Edition ................................................................. 13
Fixes for the Canadian Edition .................................................................13

Known Issues and Comments .....................................................................14

General .......................................................................................................14
Windows 8 Professional and Server 2012 Standard Operating Systems ........20
Windows 7 Professional and Server 2008 R2 Standard Operating Systems ........21
Windows Vista and Server 2008 Operating Systems ...................................24
July 2016 Update (Build 19.7.58)

U.S. Payroll Tax Tables—July 2016 Update

Payroll tax tables have changed for the following jurisdiction:

- Idaho
July 2016 Update (Build 19.7.57)

Canadian Payroll Tax Tables—July 2016

This section highlights federal and provincial tax changes.

Federal Payroll Tax Changes

Budget 2016 proposes to restore the Labour-Sponsored Venture Capital Corporations (LSVCC) federal tax credit to 15% for purchases of approved shares in provincially registered LSVCCs for 2016 and subsequent tax years. For more information about the tax implications of this change, visit the Canada Revenue Agency website.

For information about how this change is implemented in Sage 100 Contractor, see "Federal tax credit for LSVCCs", later in this section.

Provincial and Territorial Payroll Tax Changes

The following provinces and territories mandated payroll tax changes, effective July 1, 2016:

- British Columbia
- New Brunswick
- Newfoundland and Labrador
- Prince Edward Island

For detailed information on personal amounts, see the TD1 form for each province or territory.

Enhancements for the Canadian Edition

Federal tax credit for LSVCCs

Starting with the 2016 budget year, employees may be eligible for a federal tax credit when they purchase shares of provincially registered Labour-Sponsored Venture Capital Corporations (LSVCCs).

You record the net cost of an employee's purchase of provincially registered LSVCCs in the 5-2-1 Employees window, using one of four existing boxes on the General Information tab. Sage 100 Contractor uses this amount to calculate the employee's federal tax credits when computing payroll.

To record an employee's purchase of provincially registered LSVCCs, Sage 100 Contractor:

1. Open the 5-2-1 Employees window.
2. Use the data control box to display the employee record.
3. On the General Information tab, in any one of the following boxes, type LSVCC: followed by the amount withheld from this employee's annual pay to purchase a provincially registered LSVCC:
Sage 100 Contractor recognizes the first amount (in the order listed above) that is preceded by "LSVCC:" as the amount eligible for the federal tax credit.

You do not need to include a thousands separator in the amount, but you must include "LSVCC:" as the initial characters in the box.

Also, you do not have to use the same field to record provincially registered LSVCC amounts for each employee.

**Federal tax credits for federally registered LSVCCs**

Federal tax credits for *federally registered* labour-sponsored funds are calculated based on the net cost you record in the **Labour-Sponsored Fund** box on the **Compensation** tab.
February 2016 Update (Build 19.7.52)

Fixes for U.S. and Canadian Editions

We fixed the following issues in both the U.S. and Canadian editions in the February 2016 product update:

- The 4-7-5 Reconcile Credit Card Statements window now displays credit card charges correctly by transaction and subaccount.
- The 11-02 Work Orders/Invoices/Credits window now prevents you from saving a record with a duplicate number even if job-level security prevents you from viewing records with the same number.

Fixes for the Canadian Edition

The following issues were fixed specifically for the Canadian edition:

- The 5-2-3 Compute Payroll window now correctly computes Workers Compensation for the payroll record in which an employee’s wages initially exceed the annual maximum that is subject to Workers' Compensation.
- The 5-2-3 Compute Payroll window now correctly computes vacation accruals for payroll records on which there is a vacation payout, when the vacation accrual uses the 4 - % Reg Pay calculation method.

Fixes for the U.S. Edition

The following issue was fixed specifically for the U.S. Edition:

- The 5-1-6 and 5-1-11 Certified Payroll reports now correctly report benefits for the new 19-Per Hour (worked hours) payroll calculation method.
January 2016 Update (Build 19.7.43)

U.S. Payroll Tax Tables

Payroll tax tables have changed for the following jurisdictions:

- District of Columbia
- Maryland Local Tax
- Massachusetts
- Missouri
- North Carolina
- North Dakota
- Oregon
- Rhode Island
- Vermont

Enhancements for the U.S. Edition

You can update ACA settings for all employees at once

Sage 100 Contractor provides a very effective way to update ACA settings at the beginning of a new calendar year or any time you need to change these settings for all employees.

Use the new Update All Employee ACA Settings window to update ACA settings in all your employee records from a single point in the program, rather than changing the settings for each employee individually.

**NOTE:** When changing ACA settings using this window, you update each setting independently (except for the 1A Offer of Coverage Code, as noted in step 4).

To change ACA settings for all employees at once:

1. Open the **5-2-1 Employees** window.
2. Click **Options > Update All Employee ACA Settings**.
3. In the **Update All Employee ACA Settings** window that opens, specify the month and the year as of which the new settings will be effective.
4. Change the **Existing value** and **Change to** boxes for the following settings, as needed:
   - **Offer of Coverage Code**. You cannot change this code to a blank. If you offered no coverage, select 1H as the code.

   **NOTE:** If you change the Offer of Coverage Code to 1A, 1F, 1G, 1H, or 1I, the program changes the Share of Min Plan Premium to zero for all employees that are assigned to this code.
TIP: To clear any existing non-zero premiums you may have entered for employees assigned to codes 1A, 1F, 1G, 1H, or 1I, enter the same code in the Existing value and Change to boxes. For example, if you enter 1A in both boxes, when you click Update, the program clears the Share of Min Plan Premium for all employees assigned to the 1A Offer of Coverage Code.

Safe Harbor Code.

Share of Min Plan Premium.

You can change this value from zero to another amount, except for Offer of Coverage Code 1A, 1F, 1G, 1H or 1I. (The Share of Min Plan Premium amount must be zero for codes 1A, 1F, 1G, 1H, and 1I.)

TIP: You can clear all existing premium amounts by entering zero in the Change to box.

For each setting you changed, click the [Update] button.

View current ACA Settings for all employees

To display current ACA settings for all employees:

1. In the Update All Employee's ACA Settings window, specify an Effective Beginning month and year.
2. Click the [View] button.
   
   The ACA Settings window opens, listing ACA settings for all employees in a grid.

You can use the ACA Settings window to check the existing settings before you make any changes.

After changing ACA settings, use the ACA Settings window to verify your changes. If you need make additional adjustments for an individual employee, select the employee on the grid, and then click the [Drill Down] button. The employee record opens, where you can change the settings as needed.

Fixes for U.S. and Canadian Editions

Fixes for the Canadian Edition

The following issues were fixed specifically for the Canadian edition:

- If an employee has two calculations that are both designated for Box 40, the amounts are now combined into a single total in Box 40 on their T4 form.

- Amounts in boxes 14, 24 and 26 on T4 Slips are now correctly reported for employees who have been paid a non-taxable per diem.

- When you generate Records of Employment from the 5-4-1 Federal Reporting by Aatrix window, amounts are now correctly filled in for monthly and semi-monthly payroll, provided that the Final Pay Period Ending Date on the first semi-monthly employee's ROE matches the period end date in their payroll record. If it does not, you must either enter the correct ending date for the ROE or change the period end date in the payroll record, and then run the report again.
Clicking the Contact Us link now displays the Canadian contact web page.

Fixes for the U.S. Edition

The following issue was fixed specifically for the U.S. Edition:

- In the 5-4-1 Federal Tax Forms and eFiling by Aatrix window, the preparer grid no longer shows unassigned federal tax columns. Now, payroll calculations appear on the grid only if they are actually used in payroll records.
Federal Payroll Tax Changes

The federal government mandated the following payroll tax changes for 2016:

- The annual personal exemption increased to $4,050 for 2016.
- The Percentage Method tax tables changed.

Other Government-Mandated Payroll Tax Changes

Payroll tax tables changed for the following jurisdictions:

- California
- Connecticut
- Illinois
- Kentucky
- Maine
- Minnesota
- New Mexico
- New York and Yonkers
- Oklahoma
Canadian Payroll Tax Tables—December 2015

This section highlights federal, provincial, and Quebec tax changes.

For more information about these changes, and for information on Employment Insurance, see the Canada Revenue Agency website.

**Federal Payroll Tax Changes**

Changes to Canadian payroll taxes include the following:

- Income tax thresholds and personal amounts are indexed for 2016.
- EI maximum annual insurable earnings and the EI premium rate changed.
- CPP maximum pensionable earnings and the basic exemption changed for 2016. The maximum contribution amount also changed.

**Quebec Payroll Tax Changes**

Changes to Quebec payroll taxes for 2016 include the following:

- The QPP maximum contribution amount and contribution rate changed.

**Other Provincial and Territorial Payroll Tax Changes**

The following provinces and territories mandated payroll tax changes, effective January 1, 2016:

- Alberta
- British Columbia
- New Brunswick
- Newfoundland and Labrador
- Northwest Territories
- Nunavut
- Ontario
- Saskatchewan
- Yukon

For detailed information on personal amounts, see the TD1 form for each province or territory.
Enhancements in Version 19.7

You will find the following new features and enhancements in Sage 100 Contractor Version 19.7.

General Improvements

Version 19.7 introduces the following enhancements in both the U.S. and Canadian editions of Sage 100 Contractor.

- A new calculation method, 19 - Per Hour (worked hours) is available in the 5-3-1 Payroll Calculations window. Payroll computed for this code (in the 5-2-3 Compute Payroll window) is based on Regular, Overtime, Premium, and Piece Pay hours.

- The help topic "Calculation Methods, Tax Types, and Calculation Types" has been corrected. It now states that payroll computed for the Per Hour (all hours) calculation method includes all types of hours, both worked (Regular, Overtime, Premium, and Piece Pay) as well as non-worked hours (Sick, Vacation and Holiday).

Enhancements for the U.S. Edition

Changes to support federal electronic reporting requirements

New federal regulations in the United States require that you indicate the employee's consent when transmitting 1094/1095 (B and C) and W-2 forms electronically, and vendor consent when you transmit vendor 1099 forms electronically.

In addition, when submitting 1094-B or 1095-B reports, you must provide one of the following ACA Policy Origin Codes:

- Unassigned
- A - Small Business Options Program
- B - Employer-sponsored coverage
- C - Government-sponsored program
- D - Individual market insurance
- E - Multi-employer plan
- F - Misc. min. essential coverage

Sage 100 Contractor provides the following new options to help you to meet these requirements:

- To indicate employee consent to transmit W-2 information, you select a new Consent for Electronic W-2 check box on the Compensation tab in employee records.
- To indicate employee consent to transmit ACA information, you select a new Consent for Electronic ACA check box on the ACA tab in employee records.
To indicate vendor consent, you select a new **Aatrix Electronic Consent** check box and provide a recipient email address on the **Financial Information** tab in vendor records.

- You select an **ACA Policy Origin Code** for your company using the new option on the **General Information** tab of the **7-2 Company Information** window.

Your selections for these options are used when you submit Transmittal B forms and consent forms electronically.

### Submitting new consent forms electronically

You use the following new reports in the **5-4-1 Federal Tax Forms and EFiling by Aatrix** window to send consent for W-2, 1095 C, and 1099 forms electronically:

- 2015 1095/1094-C
- 2015 1095/1094-B
- Electronic 1095 Consent
- Electronic W2 Consent

You use the new Electronic 1099 Consent report in the **4-5 Vendor 1099 Forms and EFiling by Aatrix** window to send consent for vendor 1099 forms.

### Enhanced ACA Reports

Version 19.7 includes a new report, **5-4-3-31 ACA Employee Count Reconciliation**, to help you reconcile your 1094/1095-C ACA forms to your payroll records. This report includes a count of all employees who worked 130 hours or more each month, including exempt employees.

We have renamed the **5-4-3 ACA Hours Allocation** report to **5-4-3-21 ACA Full Time Equivalent Count** report, which reflects the basis of the report and helps to distinguish it from the new report. (This report does not include exempt employees.)

You can now find both reports under the new menu item **5-4-3 ACA Reports**.

### Changes for the California Paid Sick Leave Act

As of July 1, 2015, employees working in California for 30 days or more for the same employer are entitled to receive paid sick leave, accrued at the rate of one hour for every 30 hours worked.

We have updated the following windows and reports in Sage 100 Contractor to accommodate this change for California and other jurisdictions where you are required to accrue paid sick leave for employees:

- **5-2-1 Employees**. You use the existing Accrued Sick, Accrual Rate, and Accrual Method fields on the Compensation tab to calculate accrued sick time.
  - You use two new fields to restrict the sick leave accrual to a maximum amount and to carry forward the previous year’s balance:
In the **Accrual Max** box, enter the maximum amount of paid sick leave that the employee can accrue. (This is normally the legal maximum for the state, such as 6 days or 48 hours.)

This maximum is used during the computation of payroll to determine whether sick leave must be accrued.

You can change the amount displayed in the **Last Year Carry Forward** box, if necessary. At the beginning of a new payroll year, Sage 100 Contractor brings forward the employee’s Accrued Sick balance from the previous year and displays the amount in this box.

This amount is reported on the Sick Leave Verification Report as the accrued sick balance from the previous year.

**5-2-2 Payroll Record** and **5-2-3 Compute Payroll**. Sick leave accrual is calculated for each payroll record when payroll is computed.

**5-1-8-81 Sick Hours Earned and Used report**. This new report shows how many paid sick days each employee earned and how many they used for each pay period, as required under the new California legislation. It also shows a running balance for each employee at the end of each pay period, and includes the amount carried forward from the previous year.

### Filter for unneeded payroll calculations in the Aatrix W-2 preparer grid

By default, Sage 100 Contractor sends all payroll calculations to the W-2 preparer grid when you generate W-2 forms. If your company uses a large variety of payroll calculations, it can be very inconvenient to have to scroll through columns for calculations that are not required for W-2 preparation.

Now, you can filter unnecessary payroll calculations, so that only calculations required for W-2 forms appear in the grid. When you turn on this feature, the following payroll calculations are not sent to the W-2 preparer grid if the W-2 box is blank:

- Employer SUI, Liability, or Advance Deduction
- Employer Workers Comp
- Employer SDI
- Tax Type 0-None, if one of the following conditions is also true:
  - Employer Cost and all Subject To boxes are not selected
  - Deduct from Employee and all Subject To boxes are selected

**NOTE:** Sage 100 Contractor creates a [SkipPayrollCalcsForW2s.log](C:\Program Data\Sage\Sage 100 Contractor) file in the C:\Program Data\Sage\Sage 100 Contractor folder that lists all the skipped calculations.

**To activate the filter in the W-2 preparer grid:**

1. Create a blank text file with the exact name `SkipPayrollCalcsForW2s.config`.
2. Save the file to the `C:\Program Data\Sage\Sage 100 Contractor` folder.
Fixes in Version 19.7

- If you do not use Document Control, Job Document menu items are no longer listed on the Projects tab in the Activity Center.

Fixes for the U.S. Edition

The following issues were fixed specifically for the U.S. Edition:

- Certified payroll reports now appear only in the 5-1-11 Certified Payroll Forms window, not in the 5-4-2 State Forms window.
- In the 5-1-11 Certified Payroll Forms window, you can now print reports for all jobs marked for certified reporting that have a status of 3 - Contract or 4 - Current, even if no payroll has been recorded for them.

Fixes for the Canadian Edition

The following issues were fixed specifically for the Canadian edition:

- In the 5-3-1 Payroll Calculation window, you can select a Benefit code for union and other reports even if the Calculation Type is set to 1-Deduct from Employee and the Tax Type is set to 0-None.
- A vacation payout amount you enter in the 5-2-2 Payroll Record window persists after you save the amount, close the window, and then reopen the payroll record.
Known Issues and Comments

The following sections describe known issues and problems in Sage 100 Contractor Version 19.7.

General

Internet access required for Sage 100 Contractor

Sage 100 Contractor features, such as printing or e-filing tax forms, submitting enhancement requests, accessing Help, or downloading periodic product or tax updates all require Internet access.

To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is installed on has access to the Internet.

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to connect to the Internet to obtain licenses. Once installation is complete, you can check out license uses for each computer where Sage 100 Contractor is installed, then disconnect the Sage license server from the Internet.

**NOTE:** A static Internet connection using a compatible web browser is required for Sage Construction Anywhere. For current information on supported browsers, supported Sage 100 Contractor versions, and other system requirements, see the Sage Construction Anywhere help at http://help.sageconstructionanywhere.com/sage100contractor/help/Default.htm#01_Setup/System_requirements.htm.

Sage Advisor Update

Sage Advisor Update is a notification and download service that alerts you when an update is available for Sage 100 Contractor. You can use Sage Advisor Update to download and install updates available for Sage 100 Contractor and other Sage products for which you have a current Sage Business Care Plan.

**TIP:** Use the **Customize** settings in the Windows system tray to make sure you can view the Sage Advisor Update icon and notifications from the System Tray in your Taskbar.

For more information about Sage Advisor Update, see “About Sage Advisor Update” in the User Guide and in the Sage 100 Contractor help.

Tax Forms and eFiling by Aatrix configuration requirements

Tax Forms and eFiling by Aatrix requires an Internet connection for two reasons:

- For updating forms and executable files.
- For electronic filing (eFiling) of the forms.

If you experience an Internet connection problem, it may be due to problems communicating through an Internet firewall. Firewalls need to have access allowed through specific ports:
The Tax Forms and eFiling Updater uses standard SSL/HTTP port 80 to access the site http://updates.aatrix.com.

The eFiling component uses secure HTTPS on port 443 to access the site https://efile.aatrix.com.

By allowing access to aatrix.com, you allow both updates and eFiling. Occasionally, restrictions are tighter and only allow access to these ports by specific programs. Tax Forms and eFiling uses the following programs to access the Internet.

For updating using http on port 80 to http://updates.aatrix.com:
- aatrixforms.exe
- updater.exe
- updater2.exe

For eFiling using secure http on port 443 to https://efile.aatrix.com:
- builder.exe
- viewer.exe

**Printing reports at year-end (U.S. Edition)**

As of Version 19.2, in the U.S. Edition, if you pay retainage in the current year for a prior year invoice and then you print a 4 1 3 26 AP Aging report for the prior year, the report shows a reduced retainage amount, and the amount paid in the future period is allocated to the Current period or an aging period, depending on the due date of the retainage and the date it was paid.

Therefore, you should print these reports as part of your year-end processing to ensure that you have a set of reports that reflect the true amount of retainage outstanding at year end.

**TIP:** If you archive your data at year end, you can also print the reports from the archive company, later.

**PCI DSS Compliance**

PCI DSS stands for Payment Card Industry Data Security Standard. It was developed by the major credit card companies as a guideline to help organizations that process card payments to prevent credit card fraud, cracking, and other security weaknesses and threats.

A company processing, storing, or transmitting payment card data must be PCI-compliant or risk losing its ability to process credit card payments and being audited and/or fined. (For more information about PCI standards, see https://www.pcisecuritystandards.org/.)

Sage 100 Contractor payment processing works exclusively with Sage Payment Solutions to enable merchants to seamlessly process check and credit card transactions directly in Sage 100 Contractor. The payment processing program uses Sage Exchange, a secure payment-processing application, to connect to Sage Payment Solutions and process check and credit card transactions.
Integrating your financial and operations system with Sage Payment Solutions lets you process check and credit card transactions without storing your customers’ sensitive card information in your database. Sage Exchange transmits check and credit card details through a secure connection to Sage Payment Solutions, where they are stored in a PCI-compliant vault, protecting your from exposure to non-compliance penalties and credit card fraud.

![CAUTION:](image) To avoid non-compliance with PCI standards, do not store credit card information in Sage 100 Contractor. Such storage creates unnecessary risk for your business and your customers.

### Use Adobe Reader Version 8.1.3 or later for faxing

Customers have reported problems faxing from Sage 100 Contractor with versions of Adobe Reader earlier than 8.1.3. Adobe Reader Version 8.1.3 and later support faxing from Windows and from Sage 100 Contractor.

![IMPORTANT:](image) To fax from Sage 100 Contractor, the Windows Fax Service component must be installed with your Windows operating system. For more information about installing the Windows Fax Service component, see the Sage 100 Contractor Help topic, “Installing the Windows Fax Service component.”

### Printing reports to PDF or exporting to Excel?

When you print reports to PDF, you may find that the size of the PDF file is unexpectedly large and the resolution of the displayed PDF is not optimal.

To create a substantially smaller PDF file with good resolution, you can run Sage 100 Contractor in Compatibility Mode (compatible with Windows 7), and then print the report.

![NOTE:](image) You cannot export to Microsoft Excel when running Sage 100 Contractor in Compatibility Mode if you use Microsoft Office 2013.

We have not encountered this issue during testing, nor has it been reported for Windows Server 2012 R2.

### About network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable communication among computers on a network. By default, Sage 100 Contractor uses the TCP starting port 48750. Certain configurations can potentially disable the communication:

- File sharing on computers running the Windows 8, Windows 7, Vista, Server 2008, Server 2008 R2, and Server 2012 operating system must be enabled. To enable file sharing, follow the instructions in the Windows Help.
- TCP communication requires the selection of port numbers that are not in use by other processes on the local computer.
- Software firewalls running on the local computer can be configured to block processes from opening TCP ports, which will prevent communication through the TCP Remoting Channel.
Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Windows 8, Windows 7 Professional, Vista, Server 2008, or Server 2008 R2 Standard

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Windows 8, Windows 7 Professional, Vista, Server 2008, or Server 2008 R2 Standard operating systems. If the service stops, the program displays a message advising you to take further action to resolve this issue.

Configuring anti-virus software and third-party firewalls

During installation of the Sage 100 Contractor Hosting Framework, the Windows Firewall is configured automatically to allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some other firewall, however, you may need to manually adjust some settings in the firewall in order to ensure proper operation.

You can use the following basic procedure to manually configure the Windows Firewall to allow the Sage 100 Contractor Hosting Framework to communicate with other computers. Use it as the basis for manually configuring other third-party firewall products.

To configure the Windows Firewall:

   For Windows 7, click Start > Control Panel > System and Security
   For Windows 8, click Start > All apps > Control Panel > System and Security.
2. Open Windows Firewall, and then select Allow a program or feature through Windows Firewall.
3. If Sage 100 Contractor Hosting Framework is not on the list, you can add it by selecting Add Program, then browsing to the following path: \MB7\Programs\Sage.CRE.HostingFramework.Service-InstanceConfig.xml.

   **NOTE:** By default, the exception is set to allow access by any computer on the network. You can refine this setting by selecting the Change Scope button. Be aware that restricting the scope incorrectly can cause the computer to be unable to connect with some or all of the other machines on the network.

Files to exclude when manually configuring your firewall for Windows 8 Professional 32-bit

- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files\Sage\Sage 100 Contractor
- C:\ProgramData\Aatrix Software
- C:\Program Files\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data
Files to exclude when manually configuring your firewall for Windows 8 Professional 64-bit

- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 32-bit

- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files\Sage\Sage 100 Contractor
- C:\ProgramData\Aatrix Software
- C:\Program Files\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 64-bit

- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional 32-bit

- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files\Sage\Sage 100 Contractor
- C:\ProgramData\Aatrix Software
- C:\Program Files\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
• Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional 64-bit
• C:\MB7
• C:\ProgramData\Sage\Sage 100 Contractor
• C:\Program Files (x86)\Sage\Sage 100 Contractor
• C:\Program Files (x86)\Aatrix Software
• C:\ProgramData\Aatrix Software
• C:\%LocalAppData%\Sage\Sage 100 Contractor
• Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 8 Professional
• C:\MB7
• C:\ProgramData\Sage\Sage 100 Contractor
• C:\Program Files (x86)\Sage\Sage 100 Contractor
• C:\Program Files (x86)\Aatrix Software
• C:\ProgramData\Aatrix Software
• C:\%LocalAppData%\Sage\Sage 100 Contractor
• Network location of Sage 100 Contractor data

• C:\MB7
• C:\ProgramData\Sage\Sage 100 Contractor
• C:\ProgramFiles (x86)\Sage\Sage 100 Contractor
• C:\Program Files (x86)\Aatrix Software
• C:\ProgramData\Aatrix Software
• C:\%LocalAppData%\Sage\Sage 100 Contractor
• Network location of Sage 100 Contractor data

Configuring Windows Regional and Short Date Format

To specify regional formats for Windows:
1. Click the [Start] button, point to Control Panel, then click Clock, Language, and Region.
2. Click Region and Language.
3. On the Formats tab, select the format for your country.
4. Under **Date and time formats**, from the Short date format drop-down list, select the format used for your country.
5. Click [OK].
6. Close the **Clock, Language, and Region** window.

**Posting Status for a Company Created since Version 19.2**

If you created a new company using version 19.2, or higher, *in certain limited scenarios* an issue can arise after you advance the year to the first period of the new fiscal year. The new year may not be available when you try to change the posting period.

A fix to prevent this issue is included in the January 2015 update. However, if you have already encountered this issue, contact Customer Support for assistance.

**Windows 8 Professional and Server 2012 Standard Operating Systems**

**Windows 8.1 Professional and Server 2012 Standard "Sleep Mode" prevents computers from obtaining a license use**

If a computer running the Windows 8.1 Professional or Server 2012 Standard operating system is used as a license server, when it goes into sleep mode other computers on the network can't obtain a license.

To avoid this possibility, set **Sleep Mode** on your license server computer to **Never**.

**To set the Sleep Mode to “Never”:**

2. Select **Change when computer sleeps**.
3. From the **Put computer to sleep** list, select **Never**.

**Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Windows 8**

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Windows 8 Professional or Windows 8 Enterprise operating systems. If the service stops, the program displays a message advising you to take further action to resolve this issue.

**Solution for Server 2012 error message about mb7.kpr file**

If you encounter an error message about opening the mb7.kpr file when launching Sage 100 Contractor on a computer running Windows Server 2012, follow these steps to resolve the issue:

1. On the Window desktop, right-click **Start**, and then click **Explore**.
2. On the left side of the window, under **Folders**, right-click the MB7 folder, and then select **Properties**.
3. On the MB7 Properties window, click the Security tab.
4. From the list under Group or User Names, select USERS, and then click [Edit].
5. On the Permissions window, select USERS again, and under Allow, select the Full control check box.
   (Selecting Full control selects all the check boxes necessary for this solution.)
6. On the Permissions window, click [OK].
7. On the MB7 Properties window, click [OK].

Server 2012 network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication among computers on a network. File and printer sharing on computers running the Server 2012 operating system must be enabled. To enable file sharing, follow the instructions in the Windows Server 2012 Help.

Windows 7 Professional and Server 2008 R2 Standard Operating Systems

Launching Sage 100 Contractor to run as administrator for scheduling reports

**IMPORTANT:** On computers running Windows 7 Professional or Server 2008 R2 Standard, scheduling Sage 100 Contractor reports requires that you “run as administrator” or to “run the program as administrator.”

Microsoft Windows changed security rules in the Windows 7 Professional and Server 2008 R2 Standard operating systems to make your computer more secure. If you are running Sage 100 Contractor as a typical user, then you have limited privileges in some areas of the program, such as saving a report schedule. To save a report schedule, you must launch Sage 100 Contractor with the command to either Run as administrator or Run this program as an administrator.

When you select either command, the settings are limited to you personally. Your settings to run Sage 100 Contractor as administrator do not affect the next person who logs on and launches Sage 100 Contractor from this computer. Your settings on this computer can either be temporary or persistent. For example, when you select Run as administrator, you run the program as administrator for that session only. When you select Run this program as an administrator, you set program properties to always run the program as administrator when you log on to this computer.

**NOTE:** “Run as administrator” and “Run this program as an administrator” are not related to Windows 7 Professional or Server 2008 R2 Standard operating systems user groups but are limited to a specific program you are running.
To set "Run as administrator":

1. On your Windows desktop, right-click the Sage 100 Contractor program icon.
2. From the drop-down menu, to launch the program, click Run as administrator.

**NOTE:** Selecting Run as administrator only runs the current session of running Sage 100 Contractor. The setting does not persist after the session is over.

To set "Run this program as an administrator":

1. On your Windows desktop, right-click the Sage 100 Contractor program icon.
2. From the drop-down menu, click Properties.
3. On the Sage 100 Contractor Properties window, click the Compatibility tab.
4. Under Privileges Level, select Run this program as an administrator.
5. Click [Apply], and then click [OK].

**NOTE:** Selecting Run this program as an administrator always runs the program with these properties when you launch the program on this computer. The setting persists.

Windows 7 Professional, Windows 8 Professional, and Server 2008 R2 Standard "Sleep Mode" prevents computers from obtaining a license use

If a computer running the Windows 7 Professional, Windows 8, or Server 2008 R2 Standard operating system is used as a license server, when it goes into sleep mode, other computers on the network can't obtain a license.

Set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to "Never":

2. Select Change when computer sleeps.
3. From the Put computer to sleep list, select Never.

Windows Server 2008 R2 and Microsoft .NET 3.5.1

Microsoft .NET 3.5.1 must be available and enabled prior to installing Sage 100 Contractor on a Windows Server 2008 R2 machine. Server 2008 R2 comes with .NET 3.5.1 loaded but not installed, so Sage 100 Contractor doesn't install it automatically.

If you attempt to install Sage 100 Contractor without .NET 3.5.1 installed, you will receive the following message during the licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.” When you click [OK], the installation continues, but the services have not been installed so Sage 100 Contractor cannot open. The Sage.CRE.HostingFramework Service will not install unless .NET 3.5.1 has been installed. If you receive the above message during installation, install .NET Framework 3.5.1 and reinstall Sage 100 Contractor.
To verify that .NET 3.5.1 is installed on Windows Server 2008 R2:

1. Click the Start button in the lower left corner of the display.
2. Highlight Administrative Tools and select Server Manager.
3. In the Server Manager interface, click Features to display all the installed Features in the right-hand pane. Verify that .NET Framework 3.5.1 is listed.

To enable .NET 3.5.1 on Windows Server 2008 R2:

1. In the Server Manager interface, select Add Features to display a list of possible features.
2. In the Select Features interface, expand .NET Framework 3.5.1 Features.
3. Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next to .NET Framework 3.5.1 and click Next.
4. In the Confirm Installation Selections interface, review the selections and then click [Install].
5. Allow the installation process to complete and then click [Close].

NOTE: Enabling .NET Framework 3.5.1 may require a reboot.

Solution for Server 2008 R2 "Permission Error Opening File"

If you see a permission error message when launching Sage 100 Contractor on a computer running the Windows Server 2008 R2 operating system, follow these instructions:

1. On the Window desktop, right-click Start, and then click Open Windows Explorer.
2. On the left side of the window, under Computer > Local Disk, right-click the \MB7 folder, and then select Properties.
3. On the MB7 Properties window, click the Security tab.
4. From the list under Group or User Names, select USERS, and then click the Edit button.
5. On the Permissions window, select USERS again, and under Allow, select the Full control check box.

Selecting Full control selects all the check boxes necessary for this solution.
6. On the Permissions window, click [OK].
7. On the MB7 Properties window, click [OK].

Solution for Windows 2008 Server R2 Application Error Message

Under some circumstances, on servers operating Windows 2008 Server R2, you may see the following error message when trying to open a photograph or image file in Sage 100 Contractor:

"No application is associated with the specific file associated with this application."
This error message appears when you attempt to open an image file in Sage 100 Contractor but you have not yet enabled the Desktop Experience feature in Windows 2008 Server R2. If you receive this error message, install Desktop Experience using the Server Manager utility:

1. In Windows 2008 Server R2, select Start > All Programs > Administrative Tools > Server Manager.
2. In the Server Manager window, click Features (left-hand pane).
3. In the Features pane, click Add Features.
4. Select the Desktop Experience check box.
5. If you are prompted to add additional features, click [Add Required Features].
6. Click [Next].
7. Click [Install].

Windows Vista and Server 2008 Operating Systems

Solution for Server 2008 "Permission Error Opening File"

If you see a permission error message when launching Sage 100 Contractor on a computer running the Windows Server 2008 operating system, follow these instructions:

1. On the Window desktop, right-click Start, and then click [Explore].
2. On the left side of the window, under Folders, right-click the \MB7 folder, and then select Properties.
3. On the MB7 Properties window, click the Security tab.
4. From the list under Group or User Names, select USERS, then click the [Edit] button.
5. On the Permissions window, select USERS again, and under Allow, select the Full control check box. Selecting Full control selects all the check boxes necessary for this solution.
6. On the Permissions window, click [OK], and then on the MB7 Properties window, click [OK].

Vista and Server 2008 “Sleep Mode” prevents computers from obtaining a license use

If you are using a Vista or Server 2008 computer as the Sage license server and it goes into Sleep Mode, the workstations cannot obtain a license use.

Use a different computer on your network to be the Sage license server. Any supported operating system can be used in place of Vista or Server 2008.

Set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to "Never":

2. Select Change when computer sleeps.
3. From the Put computer to sleep list, select Never.

**Vista, Windows 7, and Server 2008 and changing the Sage License Server computer**

On a Vista, Windows 7, or Server 2008 workstation, when you select File > Change Sage License Server > Select the computer from the list of computers on your network, the command may fail to generate a list of network computer names. To resolve this issue, click Enter the IP address or name of the computer, and then type the IP address of the server computer in the box.

**Possible conflict when running scheduled reports on Vista Business 64-bit operating system**

On computers running the Vista Business operating system, the Sage 100 Contractor report scheduler may encounter a conflict with the Microsoft print spooler (splwow.exe) and may not function as expected.

To avoid this potential conflict, schedule reports on computers running a 32-bit operating system.